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ABOUT THE MOS TESTS
By preparing for the MOS tests you will find that you will greatly increase your familiarity with the
software. You will discover tools and features that you may not have previously known existed and
which may be extraordinarily useful. You will also learn that the software is capable of more than
you had expected, which may in turn increase your daily proficiency.
By earning Microsoft Office Specialist certifications you will be receiving a globally-acknowledged
and industry-recognized credential. Delivered by Certiport, this is the only credentialing program
endorsed by the Microsoft Corporation.

When you pass a Microsoft Certification exam, you become a member of the Microsoft Certified
Professional (MCP) community with access to all of the benefits provided through the Microsoft
Certification Program. You can use your Microsoft account to access the MCP member sites,
where you’ll find lots of ways to keep your skills relevant, applicable, and competitive.
Exams you pass and certifications you earn become part of your official transcript, which you
can allow potential employers to access directly. A Microsoft Certification is an industry
standard that is recognized worldwide and can help open doors to potential job opportunities. A
number of studies have validated the benefits of MOS certification:

TEST TAKING TIPS

The questions are not worded to be tricky or misleading. For success a test taker just needs to be
well versed in the software application, ready to be persistent and search for the correct answer,
and pace their self.
Here are some tips for taking the test:









Learn all of the tabs and associated groups
Be familiar with the File Tab also known as Backstage View
Learn Access Options
If you are not sure about a question, select skip to move ahead. You will be able to return to
the question at the end of the test.
If you think that you have clicked too many places looking for the answer, you can reset the
question and start again and you will not be penalized.
Keep track of the time. You neither want to move too sluggishly nor at a hurried pace.
Do not over think questions. As mentioned above, they are not worded to be misleading.
Stick to the literal. Here is an example from the MS Word Test 2007 where a question asked
test takers to change the initials of a user, you may be inclined to change the author’s
information. This would be incorrect. The author information is part of a document’s
properties and is specific to a single document. The user is set at the software level by
visiting Word Options.

UMES CENTER FOR STUDENT TECHNOLOGY COMPETENCY AND CERTIFICATION

SKILLS MEASURED
The MS Access 2010 exam measures your ability to accomplish the technical tasks listed below.
Please note that the questions may test on, but will not be limited to, the topics described in the bulleted text.

CREATE AND MANAGE A DATABASE


Use Save Object As, Open, Save and Publish, Compact and Repair Database, and Encrypt with Password
commands, create a database from a template, and set Access options



Configure the Navigation pane



Rename objects, delete objects, and set Navigation options



Apply Application Parts



Use Blank Forms, Quick Start, and user templates

*You will find all necessary instructions necessary in the training section of this document.

BUILD TABLES


Create tables in Design view



Create and modify fields



Insert a field, delete a field, rename a field, Hide or Unhide fields, Freeze or Unfreeze fields,
modify data types, modify the field description, and modify field properties



Sort and filter records




Set relationships




Use Find, Sort, and Filter commands

Define Primary Keys, use Primary Keys to create Relationships, and edit Relationships

Enter and format text



Use text effects; change the indentation, alignment, line spacing, and direction of text; change
the formatting of bulleted and numbered lists; enter text in a placeholder text box; convert text
to SmartArt; copy and paste text; use Paste Special, and use Format Painter



Import data from a single data file



Import source data into a new table, append records to an existing table, and import data as a
linked table

*Microsoft offers an excellent self-paced online training module that covers this topic available at
http://office.microsoft.com/en-us/access-help/create-tables-for-a-new-database-RZ101772997.aspx

Page | 4

UMES CENTER FOR STUDENT TECHNOLOGY COMPETENCY AND CERTIFICATION

BUILD FORMS


Create forms




Apply Form Design Tab options




Use the Themes, Controls, Header/Footer, and Tools groups

Apply Form Arrange Tab options




Use the Form Wizard, create a blank form, use Form Design tools, and create Navigation forms

Use the Table, Move, and Position groups

Apply Form Format Tab options



Use the Background and Control Formatting groups

*You will find all necessary instructions necessary in the training section of this document.

CREATE AND MANAGE QUERIES


Construct queries




Manage source tables and relationships




Use the Total row, and use Group By

Generate calculated fields




Add, remove, and rearrange fields, and use Sort and Show options

Calculate totals




Use the Show Table and Remove Table commands, and create ad hoc relationships

Manipulate fields




Use Select, Make Table, Append, and Crosstab query types

Perform calculations, use the Zoom box, and use Expression Builder

*Microsoft offers an excellent self-paced online training module that covers this topic available at
http://office.microsoft.com/en-us/access-help/create-queries-for-a-new-databaseRZ101772999.aspx

DESIGN REPORTS


Create reports




Create a blank report, use Report Design tools, and use the Report Wizard

Apply Report Design Tab options



Use the Themes, Grouping & Totals, Controls, Header/Footer, and Tools groups
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Apply Report Arrange Tab options




Apply Report Format Tab options




Add color, background images, and conditional formatting

Apply Report Page Setup Tab options




Use the Table, Move, Position, and Sizing & Ordering groups

This objective may include, but is not limited to, using the Page Size and Page Layout groups

Sort and filter records for reporting



Use the Find, Sort, and Filter commands, and use view types

*You will find all necessary instructions necessary in the training section of this document.
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SAMPLE TEST TASKS
In the previous section we addressed the skills accessed on the MS Access 2010 certification exam.
In this section we will present you with a number of examples of the type of tasks that are typically
found on MS Access certification tests. These tasks may or may not comprise the 34 questions that
will appear on your certification exam.




































Back up a database
Create a new database based on a
template
Apply a template to an existing
database
Apply a theme
Modify a Table Relationship
Enforce Referential Integrity
Name or rename a table
Add a calculated field
Change field margins
Create new forms
Create a variety of different fields
Modify dependencies
Create text or number validation rules
Use the expression builder
Use application parts
Create a look up column
Change a report layout
Modify page set up
Hide margins
Create a new query
Include but hide a field in a query
Query a single record source
Make a query ask for input
Use a formula in a query
Query multiple record sources
Change field order in a query
Edit query criteria to display only
what meets a certain condition
Use a query to automate the deletion
of multiple records
Create a calculated query
Create a crosstab query
View code
Change theme
Modify Options
Build a macro
























Create a new report
Apply a filter to report or table
Adjust the primary key field
Create a new table
Change the background color
Create a split form
Protect the database
Modify table layout
Add a new record to a database
Modify an existing record
Sort records
Apply conditional formatting
Rename a database
Import data into Access from a
different file source
Modify a field description
Use text effects
Modify line spacing
Convert text to SmartArt
Paste Special
Import data as a linked table
Change indentation
Modify bullets

Page | 7

UMES CENTER FOR STUDENT TECHNOLOGY COMPETENCY AND CERTIFICATION

TRAINING INSTRUCTION FROM THE MICROSOFT CORPORATION
DATABASE BASICS
WHAT IS ACCESS?
Access 2010 is a database application design and deployment tool that you can use to keep track of important information. You can keep
your data on your computer, or you can publish to the Web — so others can use your database with a web browser.
Many people start using Access when the program that they are using to keep track of something gradually becomes less fit for the task. For
example, suppose you are an event planner, and you want to keep track of all the details that you need to manage to make your events
successful. If you use a word processor or spreadsheet program to do this, you can easily run into trouble with duplicate and inconsistent
data. You can use calendaring software, but tracking financial information in a calendar isn't a good fit.

Relational databases in Access
Sometimes you need a relational database to track such information — a storehouse of data that has been separated into smaller collections
of data (called tables) to eliminate redundancy, and then related together based on common bits of information (called fields). For example,
an event planning relational database might contain a table with customer information, a table with vendor information, and a table with
event information. The table with event information might have a field to relate it to the customer table, and a field to relate it to the vendor
table. That way, for example, if a vendor's phone number changed, the information could be changed once in the vendor table, instead of in
every event that involved the vendor.
Access is a tool that you can use to quickly and easily develop relational database applications that help you manage information. You can
create a database to help you keep track of just about any kind of information, such as inventory, professional contacts, or business
processes. In fact, Access comes with templates that you can use right away to track a variety of information, making things easy even for a
beginner.

When you open Access
When you start Access 2010, you see the Microsoft Office Backstage view, where you can get information about the current database, create
a new database, open an existing database, and view featured content from Office.com.
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FIND AND APPLY A TEMPLATE
Access provides you with a wide variety of templates that you can use to speed up your database creation process. A template is a ready-touse database that contains all of the tables, queries, forms, and reports needed for performing a specific task. For example, there are
templates that can be used to track issues, manage contacts, or keep a record of expenses. Some templates contain a few sample records to
help demonstrate their use. Template databases can be used as is, or you can customize them to better fit your needs.
To find and apply a template to your database, do the following:
1.
2.

On the File tab, click New.
Under Available Templates, do one of the following:



To reuse a template that you’ve recently used, click Recent Templates, and then select the template that you want.



To use a template that you already have installed, click My Templates, and then select the template that you want.



To find a template on Office.com, under Office.com Templates, click a template category, select the template that you want, and
then click Download to download the template from Office .com to your computer.
NOTE You can also search for templates on Office.com from within Access. In the Search Office.com for templates box,
type one or more search terms, and then click the arrow button to search.

3.
4.

Optionally, click the folder icon next to the File Name box to browse to a location where you want to create the database. If you don't
indicate a specific location, Access creates the database in the default location that is displayed below the File Name box.
Click Create.
Access creates the database and opens it for use.

CREATE A DATABASE FROM SCRATCH
If none of the templates fits your needs, or if you have data in another program that you want to use in Access, you may decide that it is
better to create a database from scratch. In Access 2010, you have a choice: a standard desktop database, or a web database.
To create a new database, do the following:
1.
2.

Start Access.
On the New tab in Backstage view, click Blank Database or Blank Web Database.
IMPORTANT The choice that you make here will determine what features are available in the database. Desktop databases cannot be
published to the Web, and web databases do not support some desktop features, such as totals queries.

3.

On the right, type a name for your database in the File Name box.

To change the location in which you create the file, click Browse
location, and then click OK.
4.

next to the File Name box, browse to and select the new

Click Create.
Access creates the database, and then opens an empty table (named Table1) in Datasheet view.

5.

Access puts the cursor in the first empty cell in the Click to Add column of the new table.

Page | 9

UMES CENTER FOR STUDENT TECHNOLOGY COMPETENCY AND CERTIFICATION
To add data, begin typing — or you can paste data from another source, as described in the section Paste data from another source
into an Access table, later in this article.



Entering data in Datasheet view is designed to be very similar to entering data in an Excel worksheet. The main restriction is that
data must be entered in contiguous rows and columns, starting at the upper-left corner of the datasheet. You should not try to
format your data by including blank rows or columns as you might do in an Excel worksheet, because doing so will waste space in
your table. The table merely contains your data. All visual presentation of that data will be done in the forms and reports that you
design later.



The table structure is created while you enter data. Any time that you add a new column to the datasheet, a new field is defined in
the table. Access sets the data type of the field based on the type of data that you enter. For example, if you have a column in which
you have entered only date values, Access will set the data type of that field to Date/Time. If you later attempt to enter a non-date
value (such as a name or a phone number) in that field, Access displays a message informing you that the value does not match the
data type of the column. When possible, you should plan your table so that each column contains the same type of data, whether it
is text, dates, numbers, or some other type. This makes it much easier to build queries, forms, and reports that select just the data
that you want.

If you do not want to enter data yet, click Close

.

NOTE Access will delete Table1 if you close it without saving.

OPEN AN EXISTING ACCESS DATABASE
TIP To quickly open one of the last several databases that you had open, on the File tab, click Recent, and then click the file name.

1.
2.
3.
4.

On the File tab, click Open.
Click a shortcut in the Open dialog box — or, in the Look in box, click the drive or folder that contains the database that you want.
In the folder list, double-click folders until you open the folder that contains the database.
When you find the database, do one of the following:




To open the database in default open mode, double-click it.



To open the database for read-only access, so that you can view it but cannot edit it, click the arrow next to the Open button, and then
click Open Read-Only.



To open the database for exclusive access, so that no one else can open it while you have it open, click the arrow next to the Open
button, and then click Open Exclusive.



To open the database for read-only access, click the arrow next to the Open button, and then click Open Exclusive Read-Only Other
users can still open the database, but they only have read-only access.

To open the database for shared access in a multiuser environment, so that both you and other users can both read and write to the
database at the same time, click Open.

If you can't find the database that you want to open
1.
2.
3.
4.

In the Open dialog box, click the My Computer shortcut — or, in the Look in box, click My Computer.
In the list of drives, right-click the drive that you think might contain the database, and then click Search.
Enter your search criteria, and then press ENTER to search for the database.
If the database is found, open it by double-clicking it in the Search Results dialog box.
NOTE Because the search was initiated from the Open dialog box, you must click Cancel in that dialog box before the database will

open.
You can directly open a data file in an external file format (such as dBASE, Paradox, Microsoft Exchange, or Excel). You can also directly open
any ODBC data source, such as Microsoft SQL Server or Microsoft FoxPro. Access automatically creates a new Access database in the same
folder as the data file, and adds links to each table in the external database.
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GET STARTED USING YOUR NEW DATABASE
Depending on the template that you used, you might need to do one or more of the following to get started with the new database:



If Access displays a Login dialog box with an empty list of users, use the following procedure to get started:
1.
2.
3.
4.

Click New User.
Fill in the User Details form.
Click Save & Close.
Select the user name you just entered, and then click Login.



If Access displays an empty datasheet, you can begin typing data directly into that datasheet, or click other buttons and tabs to explore
the database.



If Access displays a Getting Started page, you can click links on that page to learn more about the database, or click other buttons and
tabs to explore the database.



If Access displays a Security Warning message in the message bar, and you trust the source of the template, click Enable Content. If
the database requires a login, you will need to log in again.

For desktop and web databases, you also want to begin with one of these steps:




Add a table and then input data into the table.
Import data from other sources, creating new tables in the process.

ADD A TABLE
You can add a new table to an existing database by using the tools in the Tables group on the Create tab.

NOTE In a web database, only the Table command is available in the Tables group.

Regardless of which view you start in, you can always switch to the other view by using the view buttons on the status bar of the Access
window.
Create a blank table in Datasheet view In Datasheet view, you can enter data immediately, and let Access build the table structure behind
the scenes. Field names are assigned numerically (Field1, Field2, and so on), and Access sets the field data type, based on the type of data
that you enter.

1.
2.
3.

On the Create tab, in the Tables group, click Table
.
Access creates the table, and then places the cursor in the first empty cell in the Click to Add column.
To add data, begin typing in the first empty cell — or you can paste data from another source, as described later in this article.



To rename a column (field), double-click the column heading, and then type the new name.
TIP Give a meaningful name to each field, so that you can tell what it contains without having to look at the data.
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To move a column, select it by clicking its column heading, and then drag it to where you want it. You can also select several
contiguous columns and drag them all to a new location together.
To add more fields to your table, you can either begin typing in the Click to Add column in Datasheet view, or you can add
new fields by using the commands in the Add & Delete group on the Fields tab.

Create a table starting in Design view In Design view, you first create the new table's structure. Then you either switch to Datasheet view to
enter data, or you enter your data by using some other method, such as with a form.
NOTE Design view is not available for tables in a web database.

1.
2.
3.

4.
5.

On the Create tab, in the Tables group, click Table Design.
For each field in your table, type a name in the Field Name column, and then select a data type from the Data Type list.
You can enter additional information for each field in the Description column. The description that you enter is displayed in the status bar
when the insertion point is in that field, and is used as the status bar text for any controls that you create by dragging the field from the
Field List pane to a form or report, and for any controls that are created for that field by the Form Wizard or Report Wizard.
After you have added all of your fields, save the table:

 On the File tab, click Save.
You can begin entering data into the table at any time by switching to Datasheet view, clicking in the first empty cell, and typing. You can
also paste data from another source, as described in the next section.

PASTE DATA FROM ANOTHER SOURCE INTO AN ACCESS TABLE
If your data is currently stored in another program, such as Excel, you can copy and paste your data into an Access table. In general, this
works best if your data is already separated into columns, as they are in an Excel worksheet. If your data is in a word processing program, you
should first separate the columns of data by using tabs, or convert the data into a table in the word processing program, and then copy the
data. If your data needs any editing or manipulation (for example, separating full names into first and last names), you might want to do this
before you copy the data, particularly if you are not familiar with Access.
When you paste data into an empty table, Access sets the data type of each field according to what kind of data it finds there. For example, if
a pasted field contains nothing but date values, Access applies the Date/Time data type to that field. If the pasted field contains only the
words "yes" and "no", Access applies the Yes/No data type to the field. Access names the fields depending on what it finds in the first row of
pasted data. If the first row of pasted data is similar in type to the rows that follow, Access determines that the first row is part of the data and
assigns the fields generic names (Field1, Field2, and so on). If the first row of pasted data is not similar to the rows that follow, Access uses the
first row as field names, and excludes the first row in the actual data. If Access assigns generic field names, you should rename the fields as
soon as possible to avoid confusion. Use the following procedure:
1.
2.
3.

On the File tab, click Save to save the table.
In Datasheet view, double-click each column heading, and then type a name for the column.
Save the table again.

IMPORT OR LINK TO DATA FROM ANOTHER SOURCE
You might have data that you've been collecting in another program that you would like to use in Access. Perhaps you work with people who
store their data in other programs, and you want to work with their data in Access. Or, maybe you have multiple disparate sources of data,
and need a "landing pad" where you can bring them all together for deeper analysis.
Access makes it easy to import or link data from other programs. You can bring in data from an Excel worksheet, from a table in another
Access database, from a SharePoint list, or from any of a variety of other sources. The process differs slightly depending on the data source,
but these instructions will get you started:
1.

On the External Data tab, in the Import & Link group, click the command for the type of file that you are importing from.
For example, if you are importing data from an Excel worksheet, click Excel. If you don't see the correct program type, click More.
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NOTE If you can't find the correct format type in the Import & Link group, you may need to start the program in which you
originally created the data, and then use that program to save the data in a file format that Access supports (such as a delimited text
file), and then import or link to the data.

2.
3.
4.

In the Get External Data dialog box, either click Browse to browse to the source data file, or type the full path of the source data file in the
File name box.
Click the option that you want under Specify how and where you want to store the data in the current database. You can create a new
table by using the imported data, or create a linked table that maintains a link to the data source.
Click OK.
Depending on your choice, the Link Objects dialog box or the Import Objects dialog box opens.

5.
6.

Use the dialog box to finish the process. The exact procedure you follow depends on the import or link option that you chose.
On the last page of the wizard, click Finish.
If you chose to import, Access asks whether you want to save the details of the import operation that you just completed.

7.

If you think that you will be performing this same import operation again, click Save import steps, and then enter the details.
You can then easily reproduce the import operation by clicking Saved Imports in the Import group on the External Data tab,
clicking the import specification, and then clicking Run.

8.

If you don't want to save the details of the operation, click Close.
Access imports the data into a new table, and then displays the table under Tables in the Navigation Pane.

IMPORT DATA FROM A SPREADSHEET OR OTHER PROGRAM
If you are familiar with other database or spreadsheet programs, you probably know the basics of how these applications work and what
databases are used for. Access differs from many other database applications by allowing you to create relational databases, and it further
differs from most spreadsheet programs by offering tools for developing sophisticated queries, forms, and reports. Access also provides
many options for working with other database programs, such as SQL Server.

Import an Excel worksheet into Access
Many people begin to explore Access after first building a list in Excel. Excel is a great place to start a list, but as the list grows, it becomes
harder to organize and keep updated. Moving the list to Access is usually the next logical step.
A database table is similar in structure to a worksheet, in that data is stored in rows and columns. As a result, it is usually easy to import a
worksheet into a database table. The main difference between storing your data in a worksheet and storing it in a database is in how the data
is organized. Simply importing your entire worksheet as a new table in a database will not solve the problems associated with organizing and
updating your data, particularly if your worksheet contains redundant data. To solve those problems, you must split the spreadsheet data into
separate tables, each one containing related data.

Import an Excel worksheet as a table in a new database
1.
2.

On the File tab, click New, and then click Blank Database.
Type a name for the new database in the File Name box, and then click Create.
The new database opens, and Access creates a new empty table, Table1.

3.

Close Table1.
When asked if you want to save changes to the design of Table1, click No.
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4.
5.
6.
7.
8.
9.

On the External Data tab, in the Import & Link group, click Excel.
In the Get External Data dialog box, click Browse.
Use the File Open dialog box to locate your file.
Select the file, and then click Open.
In the Get External Data dialog box, ensure that the Import the source data into a new table in the current database option is selected.
Click OK.
The Import Spreadsheet Wizard starts, and asks you a few questions about your data.

10.

Follow the instructions, clicking Next or Back to navigate through the pages. On the last page of the wizard, click Finish.
NOTE Access asks whether you want to save the details of the import operation that you just completed. If you think that you will be
performing this same import operation again, click Yes, and then enter the details. You can then easily reproduce the operation in
the future by clicking Saved Imports in the Import group on the External Data tab. If you don't want to save the details of the
operation, click Close.

Access imports the data into a new table, and then displays it under All Tables in the Navigation Pane.

Use the Table Analyzer Wizard to organize your data
After your data has been imported into an Access table, you can use the Table Analyzer Wizard to quickly identify redundant data. The wizard
then provides a simple way to organize the data into separate tables, so that it is be stored in the most efficient way. Access preserves the
original table as a backup, and then creates new tables that you can use as the basis for your database application.
1.
2.

Open the Access database that contains the table that you want to analyze.
On the Database Tools tab, in the Analyze group, click Analyze Table.
The Table Analyzer Wizard starts.
The first two pages of the wizard contain a short tutorial — complete with buttons that you can click to see examples. If you don't
see the introductory pages, but instead see a check box labeled Show introductory pages?, select the check box, and then click
Back twice to see the introduction. If you don't want to see the introductory pages again after reading the introduction, you can
clear the Show introductory pages? check box.

3.
4.

On the Which table contains fields with values that are repeated in many records? page, select the table that you want to analyze, and
then click Next.
You can let the wizard decide which fields go in which tables, or you can make that decision yourself. If you follow the wizard's suggestions,
you can still make changes to the table layout on the next page of the wizard.
NOTE If you let the wizard decide which fields to put in which tables, its choices may not always be appropriate for your data,
especially if there is not much data to work with. You should check the wizard's results carefully. On the other hand, the wizard may
suggest a more efficient organization than the one that you are thinking of, so it is a good idea to at least try the wizard's decisions
once. If you don't like the suggestions, you can still rearrange the fields manually, and you can always click Back and arrange all of
the fields yourself.

5.

Click Next. On this page, you specify which tables contain which fields. If you chose to let the wizard decide, you should see multiple tables
connected by relationship lines. Otherwise, Access creates only one table containing all of the fields. In either case, you can make changes on
this page.



You can drag fields from a table to a blank area of the page to create a new table that contains those fields. Access prompts you for a
table name.




You can drag fields from one table to another table if you think that they will be stored more efficiently there.




To undo a change, click the Undo button.

Most tables will be given an ID or a Generated Unique ID field. To learn more about the ID fields, click Tips in the upper-right corner
of the wizard.
To rename a table, double-click its title bar, type the new name, and then click OK.

Page | 14

UMES CENTER FOR STUDENT TECHNOLOGY COMPETENCY AND CERTIFICATION
6.
7.

8.

9.

After you have the fields arranged the way that you want them, click Next.
If the wizard finds records that have very similar values, it will identify those values as possible typographical errors and present a screen
where you can confirm what to do about them. Scroll through the list to find any that have values in the Correction column, and then click
the appropriate item in the drop-down list. Select (Leave as-is) to keep the wizard from making any changes to the value. When you are
finished, click Next.
The wizard asks whether you want to create a query that resembles your original table. If you have already built forms and reports that are
based on the original table, creating such a query is a good idea. If you choose Yes, create the query, the wizard renames the original table
by appending "_OLD" to the table name, and then names the new query by using the name of the original table. The forms and reports that
were based on the table now use the query for their data, and they continue to work as before.
Click Finish.
The wizard creates the new tables as specified, and then opens them. Close them when you are finished inspecting the results.

Work with data from other programs
Access 2010 provides features for working with data that is stored in other programs.
Create a new Access database that links to data in another file format You can use Access to open a file in another file format such as
text, dBASE, or a spreadsheet. Access automatically creates an Access database and links the file for you.
1.
2.
3.
4.
5.

Start Access.
On the File tab, click Open.
In the Open dialog box, click the type of the file that you want to open in the list. If you're not sure of the file type, click All Files (*.*).
If needed, browse to the folder containing the file that you want to open. When you find the file, double-click it to open it.
Follow the instructions in the wizard. On the last page of the wizard, click Finish.

Import or link data to an existing Access database You can either import data from other sources and programs into Access tables so that
the data is contained within the Access file, or you can link to the data from Access so that the data remains in the original file (outside of the
Access file).
1.

On the External Data tab, in the Import & Link group, click the format in which the data is stored.
You can import or link to data from the following sources:



Excel You can bring in data from a worksheet or a named range in an Excel workbook. Each worksheet or named range must be
imported or linked separately.



Access This is very handy for separating your process from your data, creating a split database. That is, you can use one database
to contain all your forms, reports, and macros, and keep your data in another database. You can then develop improvements
without interrupting anyone's work. You can also combine data from many different Access databases in one, making it easier
to summarize data across departments or between business partners.



ODBC database Many programs support this format, including many database server products. This helps you create "landing
pad" databases, where you combine data from different systems.



Text file You can connect to a simple text file, and can even use Access to change the contents of that file. This can help make
Access data easy to consume by a wide range of programs.







XML file This format also offers compatibility with a variety of other programs, including some web servers.



dBase file dBase is a popular alternative database system that is supported by Access

SharePoint list This makes your data usable with a web browser, the standard way to use a SharePoint list.
Data Services You can connect to web data services inside your enterprise.
HTML document
Outlook folder You can connect to Outlook folders, so you more easily integrate your contact information with the rest of your
data.

The Get External Data dialog box appears.
2.

Follow the instructions in the dialog box.
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Access will import or link the data to your database. For most formats, you must specify the location of the data, and then
choose how you want the data to be stored in your database.

FORMS

Introduction to forms
A form is a database object that you can use to create a user interface for a database application. A "bound" form is one that is directly
connected to a data source such as a table or query, and can be used to enter, edit, or display data from that data source. Alternatively, you
can create an "unbound" form that does not link directly to a data source, but which still contains command buttons, labels, or other controls
that you need to operate your application.

CREATE A FORM BY USING THE FORM TOOL
You can use the Form tool to create a form with a single mouse-click. When you use this tool, all the fields from the underlying data source
are placed on the form. You can start using the new form immediately, or you can modify it in Layout view or Design view to better suit your
needs.

Use the Form tool to create a new form
1.
2.

In the Navigation Pane, click the table or query that contains the data you want to see on your form.
On the Create tab, in the Forms group, click Form.
Access creates the form and displays it in Layout view. In Layout view, you can make design changes to the form while it is displaying data.
For example, you can adjust the size of the text boxes to fit the data, if necessary.
If Access finds a single table that has a one-to-many relationship with the table or query that you used to create the form, Access adds a
datasheet to the form that is based on the related table or query. For example, if you create a simple form that is based on the Employees
table, and there is a one-to-many relationship that is defined between the Employees table and Orders table, the datasheet displays all the
records in the Orders table that relate to the current Employee record. You can delete the datasheet from the form if you decide you do not
need it. If there is more than one table with a one-to-many relationship to the table that you used to create the form, Access does not add
any datasheets to the form.

CREATE A SPLIT FORM BY USING THE SPLIT FORM TOOL
NOTE You can add a split form to a Web database, but you cannot run the form unless you open the Web database by using Access (in other
words, it will not run in a Web browser). For more information about Web databases, see the article Build a database to share on the Web.

A split form gives you two views of the data at the same time — a Form view and a Datasheet view.
A split form differs from a form/subform combination in that the two views are connected to the same data source and are synchronized with
one another at all times. Selecting a field in one part of the form selects the same field in the other part of the form. You can add, edit, or
delete data from either part (as long as the record source is updatable, and you have not configured the form to prevent these actions).
Working with split forms gives you the benefits of both kinds of forms in a single form. For example, you can use the datasheet portion of the
form to quickly locate a record, and then use the form portion to view or edit the record.
To create a split form by using the Split Form tool:
1.
2.

In the Navigation Pane, click the table or query that contains the data that you want on your form. Or open the table or query in Datasheet
view.
On the Create tab, in the Forms group, click More Forms, and then click Split Form.
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Access creates the form and displays it in Layout view. In Layout view, you can make design changes to the form while it is displaying data.
For example, you can adjust the size of the text boxes to fit the data, if necessary. For more information about form views, see the Understand
Layout view and Design view section.

CREATE A FORM THAT DISPLAYS MULTIPLE RECORDS BY USING THE MULTIPLE ITEMS
TOOL
When you create a form by using the Form tool, the form that Access creates displays a single record at a time. If you want a form that
displays multiple records but is more customizable than a datasheet, you can use the Multiple Items tool.
1.
2.

In the Navigation Pane, click the table or query that contains the data you want to see on your form.
On the Create tab, in the Forms group, click More Forms, and then click Multiple Items.
Access creates the form and displays it in Layout view. In Layout view, you can make design changes to the form while it is displaying data.
For example, you can adjust the size of the text boxes to fit the data. For more information about form views, see the Understand Layout view
and Design view section.
When you use the Multiple Items tool, the form that Access creates resembles a datasheet. The data is arranged in rows and columns, and
you see more than one record at a time. However, a Multiple Items form gives you more customization options than a datasheet, such as the
ability to add graphical elements, buttons, and other controls. For more information about customizing your form, see the sections Fine-tune
your form in Layout view and Fine-tune your form in Design view.

CREATE A FORM BY USING THE FORM WIZARD
To be more selective about what fields appear on your form, you can use the Form Wizard instead of the various form-building tools
previously mentioned. You can also define how the data is grouped and sorted, and you can use fields from more than one table or query, as
long as you specified the relationships between the tables and queries beforehand. For more information about how to create relationships,
see the links in the See Also section of this article.
1.
2.

On the Create tab, in the Forms group, click Form Wizard.
Follow the directions on the pages of the Form Wizard.
NOTE If you want to include fields from multiple tables and queries on your form, do not click Next or Finish after you select the
fields from the first table or query on the first page of the Form Wizard. Instead, repeat the steps to select a table or query, and click
any additional fields that you want to include on the form. Then click Next or Finish to continue.

3.

On the last page of the wizard, click Finish.

Create a form by using the Blank Form tool
If the wizard or the form-building tools don't meet your needs, you can use the Blank Form tool to build a form. This can be a very quick way
to build a form, especially if you plan to put only a few fields on your form.
1.

On the Create tab, in the Forms group, click Blank Form.
Access opens a blank form in Layout view, and displays the Field List pane.

2.
3.

In the Field List pane, click the plus sign (+) next to the table or tables that contain the fields that you want to see on the form.
To add a field to the form, double-click it or drag it onto the form.
NOTES



After the first field has been added, you can add several fields at once by holding down the CTRL key, clicking several fields, and then
dragging them onto the form at the same time.
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4.
5.

The order of the tables in the Field List pane can change, depending on which part of the form is currently selected. If the field you
want to add is not visible, try selecting a different part of the form and then try adding the field again.

Use the tools in the Header/Footer group on the Design tab to add a logo, title, or the date and time to the form.
Use the tools in the Controls group of the Design tab to add a wider variety of controls to the form.
For a slightly larger selection of controls, switch to Design view by right-clicking the form and then clicking Design View.
Controls that you add while in Design view might not be compatible with the Publish to Web feature. If you plan to publish the form
to the Web, you must use only the features that are available in Layout view.

Understand Layout view and Design view
Layout view Layout view is the most intuitive view to use for form modification, and it can be used for almost all the changes that you would
want to make to a form in Access. If you create a database by clicking Blank Web Database in Microsoft Backstage View, then Layout view is
the only view that is available for designing forms.
In Layout view, the form is actually running. Therefore, you can see your data much as it will appear when you are using the form. However,
you can also change the form design in this view. Because you can see the data while you are modifying the form, this is a very useful view
for setting the size of controls or performing almost any other task that affects the appearance and usability of the form.
If you are creating a standard desktop database (as opposed to a Web database), and you encounter a task that cannot be performed in
Layout view, you can switch to Design view. In certain situations, Access displays a message that states that you must switch to Design view
before you can make a particular change.
Design view Design view gives you a more detailed view of the structure of your form. You can see the Header, Detail, and Footer sections
for the form. The form is not actually running when it is shown in Design view. Therefore, you cannot see the underlying data while you are
making design changes. However, there are certain tasks that you can perform more easily in Design view than in Layout view. You can:






Add a wider variety of controls to your form, such as bound object frames, page breaks, and charts.
Edit text box control sources in the text boxes themselves, without using the property sheet.
Resize form sections, such as the Form Header or the Detail section.
Change certain form properties that cannot be changed in Layout view.

QUERIES
OPEN AN EXISTING QUERY
If you are not familiar with the Navigation Pane, you may not know how to open a query that already exists. The Navigation Pane is a feature
that replaces the Database Window from versions prior to Access 2007. You'll see the Navigation Pane along the left side of your screen.
To open any database object, including a query, you can double-click the object in the Navigation Pane.



*Microsoft offers an excellent self-paced online training module that covers this topic available at
http://office.microsoft.com/en-us/access-help/create-queries-for-a-new-databaseRZ101772999.aspx
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REPORTS
A report is a database object that you use to display and summarize data. Reports provide a way to distribute or archive snapshots of your
data, either by being printed out, converted to PDF or XPS files, or exported to other file formats.

PARTS OF A REPORT
In Access, the design of a report is divided into sections. In a client database, you can view your report in Design view to see its sections. In
Layout view, the sections are not as obvious, but they are still there, and can be selected by using the drop-down list in the Selection group
on the Format tab. To create useful reports, you need to understand how each section works. For example, the section in which you choose
to place a calculated control determines how Access calculates the results. The following list is a summary of the section types and their uses:



Report Header This section is printed just once, at the beginning of the report. Use the report header for information that might normally
appear on a cover page, such as a logo, a title, or a date. When you place a calculated control that uses the Sum aggregate function in the
report header, the sum calculated is for the entire report. The report header is printed before the page header.




Page Header This section is printed at the top of every page. For example, use a page header to repeat the report title on every page.



Detail This section is printed once for every row in the record source. This is where you place the controls that make up the main body of the
report.



Group Footer This section is printed at the end of each group of records. Use a group footer to print summary information for a group. You
can have multiple group footer sections on a report, depending on how many grouping levels you have added.




Page Footer This section is printed at the end of every page. Use a page footer to print page numbers or per-page information.

Group Header This section is printed at the beginning of each new group of records. Use the group header to print the group name. For
example, in a report that is grouped by product, use the group header to print the product name. When you place a calculated control that
uses the Sum aggregate function in the group header, the sum is for the current group. You can have multiple group header sections on a
report, depending on how many grouping levels you have added. For more information about creating group headers and footers, see the
section Add grouping, sorting, or totals.

Report Footer This section is printed just once, at the end of the report. Use the report footer to print report totals or other summary
information for the entire report.
NOTE In Design view, the report footer appears below the page footer. However, in all other views (Layout view, for example, or when the
report is printed or previewed), the report footer appears above the page footer, just after the last group footer or detail line on the final
page.

CREATE A NEW REPORT
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Step 1: Choose a record source
The record source of a report can be a table, a named query, or an embedded query. The record source must contain all of the rows and
columns of data you want display on the report.



If the data you want is contained in an existing table or query, select the table or query in the Navigation Pane, and then continue to Step 2:
Choose a report tool.



If the record source does not yet exist, do one of the following:
Continue to Step 2: Choose a report tool and use the Blank Report tool, or
Create the table(s) or query that contains the data you want to use, select it in the Navigation Pane, and then continue to Step 2:
Choose a report tool.

Step 2: Choose a report tool
The report tools are located on the Create tab of the ribbon, in the Reports group. The following table briefly describes what each tool does:

Web-compatible reports
Reports created by using these tools are compatible with the Publish to Access Services feature, and will render in a browser. Note that Web
compatible objects are indicated by the globe on the object’s icon.

BUTTON
IMAGE

TOOL

DESCRIPTION

Report

Creates a simple, tabular report containing all of the fields in the record source you selected in the Navigation
Pane.

Blank
Report

Opens a blank report in Layout view, and displays the Field List task pane. Access creates a record source query as
you drag fields from the Field List to the report.

Client reports
Reports created by using these tools are not compatible with the Publish to Access Services feature. Adding client reports to a Web database
will not prevent the database from publishing, but the client reports will not be available in the browser. However, you can use a client report
when the database is open in Access.

BUTTON
IMAGE

TOOL

DESCRIPTION

Report

Creates a simple, tabular report containing all of the fields in the record source you selected in the Navigation
Pane.

Report
Design

Opens a blank report in Design view, to which you can add just the fields and controls you want.

Blank
Report

Opens a blank report in Layout view, and displays the Field List task pane. As you drag fields from the Field List to
the report, Access creates an embedded query and stores it in the Record Source property of the report.
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Report
Wizard

Displays a multiple-step wizard that lets you specify fields, grouping/sorting levels, and layout options. The wizard
creates a report based on the selections you make.

Labels

Displays a wizard that lets you select standard or custom label sizes, as well as which fields you want to display, and
how you want them sorted. The wizard creates the label report based on the selections you make.

Step 3: Create the report
1.

Click the button for the tool you want to use. If a wizard appears, follow the steps in the wizard and click Finish on the last page.
Access displays the report in Layout view.

2.

Format the report until it looks the way you want:





Resize fields and labels by selecting them and then dragging the edges until they are the size you want.
Move a field by selecting it (and its label, if present), and then dragging it to the new location.
Right-click a field and use the commands on the shortcut menu to merge or split cells, delete or select fields, and perform other formatting
tasks.

ADD GROUPING, SORTING, OR TOTALS
The fastest way to add grouping, sorting, or totals to a report is to right-click the field to which you want to apply the group, sort, or total,
and then click the desired command on the shortcut menu.
You can also add grouping, sorting, or totals by using the Group, Sort, and Total pane while the report is open in Layout view or Design view:
1.
2.
3.

If the Group, Sort, and Total pane is not already open, on the Design tab, in the Grouping and Totals group, click Group & Sort.
Click Add a group or Add a sort, and then select the field on which you want to group or sort.
Click More on a grouping or sorting line to set more options and to add totals.

HIGHLIGHT VALUES BY USING CONDITIONAL FORMATTING
To add conditional formatting:
1.
2.

Open the report in Layout view by right-clicking the report in the Navigation Pane and then clicking Layout View.
Select all of the controls to which you want to apply the conditional formatting. To select multiple controls, hold down the SHIFT or CTRL key
and click the controls you want.
On the Format tab, in the Control Formatting group, click Conditional Formatting.

3.

Access opens the Conditional Formatting Rules Manager dialog box.
4.
5.

In the Conditional Formatting Rules Manager dialog box, click New Rule.
In the New Formatting Rule dialog box, select a value under Select a rule type:



6.
7.
8.
9.

To create a rule that is evaluated for each record individually, select Check values in the current record or use an expression.
To create a rule that compares records to each other by using data bars, click Compare to other records.
Under Edit the rule description, specify the rule that will determine when the formatting should be applied, as well as the formatting that
you want when the rule’s criteria are met.
Click OK to return to the Conditional Formatting Rules Manager dialog box.
To create an additional rule for this control or set of controls, repeat this procedure from step 4. Otherwise, click OK to close the dialog box.
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GET A PROFESSIONAL LOOK WITH THEMES
You can now apply Office 2010 Themes to an Access database, helping you to create a consistent style across all your Office documents.
IMPORTANT If you choose an Office Theme, font, or color, it is applied to all the forms and reports in your database (not just the one you are

working on).
1.
2.

Open a report in Layout view by right-clicking it in the Navigation Pane and then clicking Layout View.
On the Design tab, in the Themes group, select the Theme, color or font that you want:




Use the Theme gallery to simultaneously set colors and fonts to a pre-designed scheme.
Use the Colors or Fonts galleries to set colors or fonts independently.

ADD IMAGES
1.
2.
3.
4.

In the Navigation Pane, right-click the report to which you want to add the image, and then click Layout View.
Click on the report where you want to add the image.
On the Design tab, in the Controls group, click Insert Image.
Do one of the following:




Use an existing image If the image you want is already in the gallery, click it to add it to the report.
Upload a new image At the bottom of the gallery, click Browse. In the Insert Picture dialog box, navigate to the image you want to
use, and then click Open.
Access adds the selected image to the report.

Add a background image
NOTE Background images cannot be added to Web-compatible reports.

1.
2.
3.

In the Navigation Pane, right-click the report to which you want to add the background image, and then click Layout View.
On the Format tab, in the Background group, click Background Image.
Do one of the following:




Use an existing image If the image you want is already in the gallery, click it to add it to the report.
Upload a new image At the bottom of the gallery, click Browse. In the Insert Picture dialog box, navigate to the image you want to
use, and then click Open.
Access adds the selected image to the report.
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PREVIEW AND PRINT A REPORT

Preview a report
1.
2.

Open the report you want to preview, or just select it in the Navigation Pane.
On the File tab, click Print, and then click Print Preview.
Access opens the report in Print Preview. You can use the commands on the Print Preview tab to do any of the following:






3.

Print the report;
Adjust page size or layout;
Zoom in or out, or view multiple pages at a time;
Refresh the data on the report;
Export the report to another file format.

To return to the database workspace, on the Print Preview tab, in the Close Preview group, click Close Print Preview.

Print a report
In addition to printing from Print Preview, you can also print a report without previewing:
1.
2.

Open the report you want to preview, or just select it in the Navigation Pane.
On the File tab, click Print.



To send the report directly to the default printer without setting printer options, click Quick Print.



To open a dialog box where you can select a printer, specify the number of copies, and so on, click Print.
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